


What is News Xpress?

News Xpress 2.0 (NX) is a USENET news reader for MS Windows 95/NT. It was designed to provide as many features as possible
while keeping its interface simple for ease of use.

Features of NX

Supports threads.

Conforms to MIME.

Supports killfile.

Supports multiple signatures.

Supports UUdecode and Base64 for decoding binary attachments automatically.
Displays inline JPEG image.

Accesses URLs embedded in articles simply by double-clicking them.

e o o o o o o



Getting started

Before running NX, please make sure you have setup the TCP/IP network properly.

To setup News Xpress
Create a folder for storing news files.
Run NX and bring up the Options dialog box by selecting the Options command in the File menu.
Select the "Server and Directory" tab.
Fill in your news server name.
If you are required to logon to access your news server, fill in your account name and password.
Fill in your mail server name.
Enter the folder name created in step 1.
Select the "Personal Information” tab.
Type in your name and e-mail address.
0 Press OK to save the changes.
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You are now ready to download all newsgroups from the news server by selecting the Connect command in the File menu. The
process may take awhile if your Network connection is slow, so be patient. Once it is done, you can subscribe to newsgroups and
view messages.

To setup multiple news servers

If you want to contact multiple news servers, you have to create a different shortcut for each server in the "Start Menu" or on the
desktop. You need to assign an unique and arbitrary profile name as an argument in the command line. This will allow NX to use
different profile for storing each settings.

For example, if you have already got one shortcut pointing to your own ISP new server, says Shortcut 1

C:\Program Files\NewsXpress\nx.exe

and you also want to use Microsoft public news server. All you have to do is to create another shortcut, says Shortcut 2, for the
Microsoft public news server

C:\Program Files\NewsXpress\nx.exe Microsoft

Note, if you are going to share the home directory, please make sure you use different newsrc filename for each profile. They cannot
be mixed as the article numbering system varies among servers.

Tips

. You can share NX newsrc file with the other newsreader, such as trn, tin, and/or xrn.

. If your network connection is slow, you can use the "Retrieve new groups only (if any)" option in the Newsgroups tab of the
Options dialog box to skip the process of downloading whole newsgroups.

See also Troubleshooting



In NX, you do not have to subscribe to a newsgroup to view its contents. However, it is a lot easier if you subscribe to newsgroups
which you want to follow, since you do not have to find them in the list of several thousands newsgroups everytime you need them.

To subscribe a newsgroup or multiple newsgroups in the newsgroups window
1  Select the All or New tab.

2  Select the desired newsgroups.

3 Select the Subscribe command in the Group menu to subscribe.

To unsubscribe a newsgroup or multiple newsgroups in the newsgroups window
1  Select the Subscribed tab.

2 Select the newsgroups.

3 Select the Unsubscribe command in the Group menu to unsubscribe.

Tip
. You can use the search box provided at the bottom of newsgroups window to filter the newsgroup list, so that only newsgroups
which contain the text you entered are shown. To show all newsgroups, you can simply clear all the text in the search box.



To sort all newsgroups in ascending order
¥ Press the Name column header button.

To rearrange newsgroups one at a time within the Subscribed list

1 Click and hold the left mouse button on the “~# icon of newsgroup you want to rearrange.
2 Drag it to the desired position.
3 Release the button to move it.



You cannot delete newsgroups directly within NX. The only way to do this is to use external editor and edit the newsrc manually. Any
text editor which can handle large file will do the job.

To remove newsgroups manually in a text editor

Close NX if it is running.

Anything can goes wrong, so backup the newsrc file first.

In your editor, open the newsrc file located in the NX home directory.
Remove unwanted newsgroups by removing entire line of each newsgroup.
Save it back once you have done with it.
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Please make sure you deselect the "Retrieve all active groups" option in the Option dialog box or those removed newsgroups will
keep coming back.



To create a message folder manually

1  Select the Folder tab in the newsgroups window to bring up the Folder properties dialog box.
2 Enter the folder name.

3 Enter the filename. If you leave this field blank, NX will use the folder name as the filename.
4 Press the OK button to accept.



To sort all folders in ascending order
¥ Press the Name column header button.

To rearrange folders one at a time within the Folder list

1 Click and hold the left mouse button on the @ icon of folder you want to rearrange.
2 Drag it to the desired position.
3 Release the button to move it.



To remove a folder

1  Select the Folder tab in the newsgroups window to bring up the Folder properties dialog box.
2 Select the folder you want to delete.

3 Press the Delete key.



To move a message from one folder to another
1  Select the message in the thread window.
2 Select the desired folder in the Transfer menu.

You can also use drag-n-drop to move a message from one folder to another providing both folders are opened
1 Click and hold the left mouse button on the icon of selected message.

2 Drag the cursor to the desired folder thread window.

3 Release the button to move the message.



To remove a message in a folder
1  Select the message you want to remove.
2 Select the Delete command in the Edit menu or simply press the Delete key.

Notes

. Removed messages will be kept in the Trash folder, if you enable the "Transfer deleted articles into the Trash folder" option in
the Miscellaneous tab of the Options dialog box.

. Removing messages in the Trash folder will permanently remove those messages.



Special Folders
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Folder Name
Copy-Self
Outbox

Trash

Purpose
Stores delivered (outgoing) messages
Stores queued (outgoing) messages

Stores removed messages



To navigate and view messages
1  Select and open a newsgroup or message folder in the newsgroups window to bring up the message list.
2  Select and open a message from the list to view the message.

Now, you can go thru all messages using keyboard or toolbar in the article window. You can also view messages selectively by
opening them individually in the thread window.

Tips
. Itis a lot easier to use keyboard to navigate and view messages in the article window. Here are a few of useful keystrokes.

Keystroke Description
Space Bar Page down or go to the next unread or selected article

Return Bring up the current newgroup thread window
n Jump to the next unread or selected article
Escape Close the article window

c Catch up the current newsgroup

. In the thread window, you can press "w" to display full line of subjects. To switch back the display mode, you simply press the
same key once again.

. In the article window, you can use the Mark Read command to mark all articles in the current thread as read and jump to the

next message.

You can pre-select messages in the thread window and go thru them in the article window by using the Next Unread command.

You can double click a URL embedded in article to access it.

You can double click a Message-ld embedded in article to view that article.

You can double click an e-mail address embedded in article to create a new message.
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See also: Decode Files



To post a message into a newsgroup or multiple newsgroups
1  Bring up the newsgroup window and select the newgroup(s)
- Or -
Bring up the thread window.

2 Select the Post command in the Article menu.
3 Compose your message.
4  Select the Send command to send it immediately
- Or -
Select the Save command to store it in the Outbox. if you want to send it later.
Tip

. If you cross-post your message to multiple newsgroups, you can specify which particular newsgroup you want your replies go
by specifying it in the Followup-To header. For example,

Newsgroups: comp.lang.c,comp.lang.c++,comp.lang.c++.moderated
Followup-To: comp.lang.c++
Subject: C vs C++
You can also use the "poster" keyword
Followup-To: poster
to tell the other readers that you prefer e-mail reply.
To enable the Followup-To header in the message composer, you have to add it into the Post template in the Options dialog

box.

See also: Attach files, Troubleshooting



There are two different types of reply method in NX.
. Follow-up is for replying messages to public newsgroups in USENET.
. Reply is for replying message via e-mail.

To reply a message in an article window
1  Select the Follow-up or Reply command in the Article menu.
2  Compose your message.
3  Select the Send command to send it immediately
- Or -
Select the Save command to store it in the Outbox. if you want to send it later.

Tips

*  You can use CC-by-mail to reply a message to the public newsgroups as well as to the original message author via personal e-
mail.

. You can use Copy-self to keep a copy of your own message in the Copy-Self folder.

See also: Attach files, Troubleshooting



You can save a message into an individual file, or a message folder (called archive).

To save a message into an individual file in an article window
b Select the Save command in the File menu.

To archive a message in an article window
b Select the Archive command in the Article menu to save it into a pre-selected folder
- Or -
Select a folder from the Transfer menu.

Tips
Archive is the easiest way to save messages because you do not have to select a folder everytime you want to archive. You can
assign a folder to archive for each group in the Newsgroups Properties dialog box.



Killfile is a filtering mechanism for removing or selecting messages in newsgroups.

Five different ways to filter messages
By (Header) How it works

Subject Specify patterns using regular expressions to apply on the Subject header. See the "Killfile actions" table shown
below for more information on the actions provided.

From Specify patterns using regular expressions to apply on the From header. Pattern is applied to both Author name
and e-mail address. See the "Killfile actions" table shown below for more information on the actions provided.

Xref Specify patterns of newsgroups to remove messages which are crossposted to those newsgroups. In addition,

you can specify the maximum number of newsgroups to remove excessive crossposted messages. Note, this
feature requires your news server to support Overview Database. The news server also need to be configured
to provide Xref header in the NNTP XOVER command.

Date Specify the number of days to remove messages which are too old.

Lines Specify the lower and upper limit of lines to remove messages which are too small or too big.

Killfile actions
Action What it does

Kill Remove messages matching the pattern specified.

Exclusive Kill Remove all except messages matching the pattern specified. Exclusive Kill patterns are preceded by "'
character. Only one Exclusive Kill pattern is allowed per newsgroup.

Autoselect Select messages matching the pattern specified. Autoselect patterns are preceded by '+' character.

The scope of killfile
Killfile can be applied locally or globally. Local killfile applies to a single newsgroup, while global killfile applies to all newsgroups.

To specify killfile in the newsgroups window

Select the Subscribed tab.
2 Select the Properties command in the Edit menu to bring up the Newsgroup Properties dialog box.
3 Select the newsgroup tab to specify local killfile

- Or -

Select the Global tab to specify global killfile.
4 Specify the killfile, see context help for more information.
5 Press OK to save changes.

To add a killfile from an article window

1  Select the Add Killfile command in the Article window.

2 Specify the header, pattern, and action you want to add.
3 Press OK to save changes.

See also: Regular Expressions



To decode file in an article window
¥ Select the Decode command in the Article menu.

To decode file in a thread window
1  Select the message in the thread window.
2 Select the Decode command in the Article menu to decode it.

To decode multipart file in a thread window

1  Make sure all parts exist.

2 Select them in the order of part number (which shown in the Subject header).
3 Select the Decode command in the Article menu to decode it.

If the multipart threading option is enabled, you do not need to select each part individually. You can simply select the one with the
@ icon. If the

83 icon is shown, it indicates one or more parts are missing. Do not bother to decode broken file, as it will not produce correct file.

Tip

. You do not need to decode file if an icon or image shows up in the article window. You can simply click on the icon or image to
save it into a file.

*  You can view file after decoded successfully by enabling the "Execute files after decoded" option in the Miscellaneous tab of
the Options dialog box.

. You can specify a folder for storing decoded files in the Miscellaneous tab of the Options dialog box.



Two ways of attaching file to a message

. Insert as a plain text by pressing the Insert El toolbar button and select the file from the Insert dialog box. The text Note, you
must not use this command to insert binary file.

. Insert as a file attachment by pressing the Attach ﬁl toolbar button and select the file from the Attachment dialog box.

To remove an attachment
1  Move the cursor to the line which shown the attachment you want to delete.
2 Press the Delete key to remove it.

Tips
. You can change the options of attachment by clicking on the & icon.
3 You can drag a file from the Explorer and drop it onto the message composer to attach it.



NX can automatically mark cross-posted messages as read in other newsgroups once you have view them, so that you do not have
to see them multiple times in different newsgroups.

To mark cross-posted messages as read automatically

1  Select the Options command in the File menu to bring up the Options dialog box

2 Select the Article tab

3 Select either the "Mark read in all groups" or "Mark read in subscribed groups" option, see context help for their descriptions

Note, this feature requires your news server to support Overview Database. The news server also need to be configured to provide
Xref header in the NNTP XOVER command.



There are different ways to select items in a listbox. If you enable the "Select Item" option for the right mouse button, you can use
the right mouse button to select multiple items much easier.

To change the right mouse button behaviour in listbox

1  Select the Options command in the File menu to bring up the Options dialog box.
2 Select the Miscellaneous tab.

3 Select either the "Select Item" or "Track Menu" option.

4 Press the OK button to save change.

Selecting items using the right mouse button

Buttons Actions
Right click Select/Deselect an item
Right click and drag Select contiguous items

Selecting items using the left mouse button

Buttons Actions
Shift+Left click Select an item or contiguous items
Ctrl+Left click Select/Deselect an item

Ctrl+Left click and drag Select contiguous items
Click on non-selected item Deselect all items

Selecting items using the space at the left margin

Buttons Actions
Left click Select/Deselect an item
Left click and drag Select contiguous items

Selecting items using the keyboard

Keystroke Actions
Space Bar Select/Deselect an item
Backspace Deselect all items

Shift+Up/Down Select contiguous items



To change the appearance of windows

1  Select the Options command in the File menu to bring up the Options dialog box.
2 Select the Fonts and Colors tab.

3 Change the desired fonts and colors.

4 Press the OK button to save changes.



To add or remove a toolbar button

1 Double click on the toolbar to bring up Customize Toolbar dialog box.
2 Add or remove button in the dialog box.

3 Press the Close button once you have done with it.

To rearrange toolbar buttons

Hold down the Shift key.

2 Click and hold the left mouse button on a toolbar button you want to rearrange.
2 Dragitto the desired position.

3 Release the mouse button to move it.
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You can use keyboard to access frequently used command. There are two types of hotkeys in NX. One is Windows type which
requires you to hold down either Ctrl or Alt at the same time. Another one type is NX hotkeys. You do not need to hold down Ctrl or
Alt key to access NX hotkeys, just a single keystroke. Besides, they are configurable.

To configure NX hotkeys

1  Select the Options command in the File menu to bring up the Options dialog box.

2 Select the Key tab.

3 Select the command you want to change from the list.

4 Press the new key, the listbox will reflect change immediately if the key is accepted.

NX hotkeys can be accessed only within the newsgroups, threads and articles windows.



W.L. Ken, Ng

Address: Rm F, 5/F, Odeon Bldg.,
26-28 Shu Kuk St., North Point,
Hong Kong

Phone: (852) 2811-8336
E-Mail:  kenng@hk.super.net



News Xpress is a freeware. Permission to use, copy and distribute this software and its documentation for non-commercial purpose
is hereby granted, provided that it is not modified.

THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT
LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.



If you found any bugs in the program and/or any spelling errors, grammatical errors or discrepancies in this help file, you can report
it to Ken Ng <kenng@hk.super.net>.



Portions of this software are based in part on the work of the Independent JPEG Group.
Portions of this software are based on Microsoft Corp.
Regular Expression support was made possible by using the code written by Henry Spencer.

| wish to express my appreciation for all the people who participated in the extensive NX beta test program, who have contributed a
great deal to user-friendliness, and robustness of News Xpress.

Special thanks to Michael Denny, Dong-Ick Lee, Brian Smither, Luu Tran, Conrad Sabatier, lvan Hyslop, and Malcolm Hoar.



Socket Errors

. If you receive the "[11004] Valid nhame, no data record of requested type" error message, it means that your news server name
is invalid. Please check your news server setting in the Options Dialog Box.

. If you receive the "[10061] Connection refused" error message, it means that there is no news software running on the server
or it can be using a different port number (other than 119). Please contact your news system administrator.

NNTP Errors

. If you receive the "No permission to talk" error message, it means that you are not allowed to use the news server. Please
contact your news system administrator.

. If you receive the "Authentication error" error message, what is likely to happen is that you are not required to logon but you
have typed in your account name and password in the Options dialog box. If this is the case, you can simply remove them. If
you are required to logon, please double check your account name or password.



NNTP Errors

. If you receive an error message complaining about the disk space, it means that your news server is running out of storage and
cannot accept any more posts. You cannot do anything except saving your post in the Outbox and try it later.

. If you receive an error message complaining about the time, it means that your system clock is not synchronous with the news
server. You should correct you system date/time in the Control Panel and then retry.

3 If you receive an error message complaining about the quoted lines, you should trim the lines quoted in your message.






This specifies the news (NNTP) server hostname.



This specifies the port number for News (NNTP) service. If this is zero, NX will use the well-known NNTP port number, which is 119.



This specifies your account name. Leave this blank if you are not required to logon.



This specifies your account password. Leave this blank if you are not required to logon or you do not want to save your password in
the system registery.



This specifies the mail (SMTP) server hostname for sending Internet mail.



This specifies the port number for Mail (SMTP) service. If this is zero, NX will use the well-known SMTP port number, which is 25.



This specifies the folder for NX to store its files, e.g. newsrc.



This specifies your name or alias.



This specifies your Internet e-mail address.



This specifies your organization name.



This specifies your default signature file.



If selected, NX will retrieve all active newsgroups from the news server in the beginning of each session. This can take quite a long
time if you have a slow network connection.



If selected, NX will retrieve only new newsgroups (if any) from the news server in the beginning of each session. You are
recommeded to use this option.



If selected, NX will not update your newsgroups information.



If checked, NX will automatically connect to your news server when it is up and running.



If checked, NX will update subscribed newsgroups information periodically during a session.



This specifies how often should NX update the newsgroups information. If this is zero, NX will update only once at the beginning of
each session.



If checked, NX will hide empty newsgroups or newsgroups without new messages in the subscribed newsgroups list.



This specifies newsrc pathname. This file is used for storing newsgroups information.



If checked, NX will backup the newsrc file before updating.



This specifies which message headers to be shown or not to be shown (if the Except checkbox is checked) in the article window.
You can specify multiple headers and separate them using commas.



If checked, NX will show all headers except those which are specified below.



This specifies the articles sorting criteria in thread window.



If checked, articles will be threaded based on References header in thread window.



If checked, articles will be threaded based on Subject header in thread window.



If checked, multipart articles will be grouped together in thread window.



This specifies the format of date/time shown in thread window. The format string consists of directives and ordinary characters. A
directive consists of the '%' character followed by a character. All possible directives are shown below:

%d 2 digits day of month (01-31)
%H 2 digits hour (00-23)

%I 2 digits hour (01-12)

%m 2 digits month (01-12)

%M 2 digits minute (00-59)

%p AM or PM

%y 2 digits year (00-99)



This specifies the limited number of headers to be retrieved each time. No limitation if this is zero.



If checked, NX will retrieve only the latest messages. This option is meaningless if you do not specify the limitation of headers
retrieval above.



If checked, NX will not retrieve old headers.



If checked, NX will not show "Re:" in Subject header.



If checked, NX will wrap lines in article window by default. This is not for message composer.



If checked, any line preceded by any one of characters specified left within message body will be highlighted. You can specify the
color in the Fonts and Colors tab.



This specifies characters for highlighting. You can type in multiple characters with no space in between.



If checked, NX will attempt to decode attachment (if any) within a message. Decoded attachment will be shown as little icon in
article window.



If checked, NX will display inline JPEG image in article window. Please make sure the Automatically UUdecode Article option above
is checked.



If selected, crossposted articles will be marked as read in all newsgroups. If you use this option, please make sure to update whole
newsrc file periodically by selecting the Retrieve All Active Groups in the Newsgroup tab once, this will eliminate out-of-date
information in the newsrc file.



If selected, crossposted articles will be marked as read in subscribed newsgroups only.



If selected, NX will not process crossposted articles.



This specifies the string used for quoting message.



If checked, the message composer will quote headers when you reply a message.



If checked, NX will ask you if you want to quote original message everytime you reply a message.



If checked, NX will prompt you to select a newsgroup to followup if the original message is crossposted.



The message composer will wrap line if the number of characters exceed the value specified here. Although most terminals can
display up to 80 characters per line, you may need to leave some spaces for others to quote your message. The most approriate
value would be around 74.



If checked, NX will use MIME standard for outgoing messages. You have to enable this option if you are going to use non US-ASCI|
character set.



This specifies the character set of outgoing messages. You can ignore this if you are not going to use MIME.



This specifies the encoding type of outgoing messages. You can ignore this if you are not going to use MIME.



This specifies the subject header template for outgoing messages with attachments. NX will replace the subject header of outgoing
message with the template if it contains a file attachment. The template string consists of directives and ordinary characters. A
directive consists of the '%' character followed by a character. All possible directives are shown below:

%s original subject string
%f filename of attachment
%p current part number

%t total part number



This specifies the upper limit of encoded lines a message can hold.



If checked, the message composer will enable the CC-by-mail option by default.



If checked, the message composer will enable the Copy-self option by default.



If checked, NX will generate Message-Id header for each outgoing message. You are recommended to disable this option.



If checked, NX will prompt you before sending messages.



Restores the default post template.



This specifies the template for creating news articles in the composer. You must specify Newsgroups and the Subject headers.



Restores the default mail template.



This specifies the template for creating mails in the composer. You must specify To and Subject headers.



Select a font for newsgroups and thread windows.



Select a font for article window.



Select a fixed pitch font for article window.



Select a font for displaying headers in article window.



Select a font for printing.



This shows the foreground color of listbox.



This shows the background color of listbox.



If checked, NX will use the default system color for listbox.



This shows the foreground color of article window and message composer.



This shows the background color of article window and message composer.



If checked, NX will use the default system color for article window and message composer.



This shows the foreground color of selection.



This shows the background color of selection.



If checked, NX will use the default system color for selection.



This shows the foreground color for displaying headers in article window.



This shows the background color for displaying headers in article window.



If checked, NX will use the default system color for displaying headers in article window and message composer.



This shows the color for highlighting quotes.



This keymap specifies key accelerator for each command. You can redefine them by selecting one command at a time and press a
key to change it. If it does not change, you are either pressing a function key which is not allowed or that particular key is already
used by another command.



This specifies your Web browser.



This specifies your FTP client.



This specifies your Gopher client.



This specifies the folder for storing decoded files.



If selected, NX will overwrite existing file.



If selected, NX will assign a different name automatically.



If selected, NX will prompt you for assigning a new filename.



If checked, NX will bring up the Decode dialog box every time you select the Decode command.



If checked, NX will launch associated viewer after decoded successfully.



If checked, deleted messages will be moved to the Trash folder instead of deleting them immediately.



If checked, NX will prompt you before you deleting messages permanently.



If checked, all messages in the Trash folder will be deleted permanently upon exiting.



If selected, the right mouse button will be used for selecting items in thread window.



If selected, the right mouse button will be used for bringing up context menu in thread window.



If checked, this will enable tooltips.



If checked, NX will display splitter (grid lines) in thread window.



If selected, the killfile will be applied to current active newsgroup only.



If selected, the killfile will be applied to all newsgroups.



If checked, this will enable Subject pattern.



This specifies the Subject pattern using regular expression. Killfile pattern is case insensitive. Check the Subject checkbox above to
enable this.



If checked, this will enable From pattern.



This specifies the From pattern using regular expression. Killfile pattern is case insensitive. Check the From checkbox above to
enable this.



If selected, killfile pattern will be applied for removing messages which match.



If selected, killfile pattern will be applied for removing message which do not match. The patterns specified above will be preceded
by a 'I' character in your killfile.



If selected, killfile pattern will be applied for selecting messages which match. The patterns specified above will be preceded by a '+'
character in your killfile.



This specifies a message header that the search will base on.



This specifies a search pattern.



This specifies a message folder for storing messages found.



If checked, NX will perform search on unread messages only.



If checked, NX will search only occurences of string that has the same pattern of upper and lower case as the string specified in the
pattern.



If checked, NX will search only whole words instead of searching inside longer words.



This specifies the folder name.



This specifies the filename.



This specifies the killfile patterns in regular expression for the Subject header. Autoselect pattern is preceded by a '+' character and
Exclusive Kill pattern is preceded by a '!' character. NX will only use the first Exclusive Kill pattern if more than one occur within the
same newsgroup.



This specifies the killfile patterns in regular expression for the From header. Autoselect pattern is preceded by a '+' character and
Exclusive Kill pattern is preceded by a '!' character. NX will only use the first Exclusive Kill pattern if more than one occur within the
same newsgroup.



This specifies the killfile patterns in regular expression for newsgroups. You can use this killfile to remove messages which are
crossposted to newsgroups matching the pattern specified.



This specifies the limited number of newsgroups crossposted. This killfile removes messages which the number of newsgroups
crossposted exceeds the value you specify.



This specifies the number of days. This killfile removes messages which are older than the number of days you specify.



This specifies the number of lines. This killfile removes messages which contain less than the number of lines you specify.



This specifies the number of lines. This killfile removes messages which contain more than the number of lines you specify.



If selected, the newsgroup name will be used to create folder for archiving articles in the selected newsgroup.



If selected, the message folder specified at the right handside will be used for archiving articles in the selected newsgroup.



This specifies the folder for archiving articles in the selected newsgroup.



This specifies the local signature file for the selected newsgroup.



If checked, the Subject template specified below will be applied to the first article. The part number will become zero for the first
article. This option is enabled only if you send the attachment as separated messages.



This specifies the encoding type for the attachment. Base64 encoding type is enabled only if you use MIME.




If checked, the attachment will be sent as separated messages.



If checked, the attachment will be splitted if its encoded lines exceeds the value specified at the right hand side.



If checked, the encoded lines will be bounded by predefined boundaries to separate them from the message body.



A regular expression consists of one or more statements separated by '|' character. A statement consists of one or more items. An
item consists of zero or more operators, and one or more characters. Any character which is reserved for operator, must be
preceded by a blackslash to match it literally.

Operator Explanation

? preceeding item is optional

* preceeding item occurs zero or more times

+ preceeding item occurs one or more times

n matches item at the beginning of a line

$ matches item at the end of a line

chars] match any character in the given list of characters; a range of characters may be specified by separating two
characters by "-"; for example, [a-z], [A-Z], or [0-9]; to specify "-" literally, make it the first or last character in the
list

[*chars] match any character not in the given list of characters

Example 1:
test|ignore|make (\$*|money)

This regexp matches any string which contains "test", "ignore"”, "make $", "make $$", or "make money".
Example 2:

ok

["a-z0-9]ok["a-2z0-9]

The first regexp matches any string which contains "ok", such as "book", "look", or "token"; the second regexp matches any string
which contains the word "ok".



The Windows Sockets specification defines a network programming interface for Microsoft Windows which is based on the "socket"
paradigm popularized in the Berkeley Software Distribution (BSD) from the University of California at Berkeley. Network software
which conforms to the Windows Sockets specification will be considered "Windows Sockets Compliant".



Copy-self is an option for saving your outgoing messages. This option can be accessed using the El button from the message
composer toolbar. NX stores your messages in the Copy-Self folder locally so that you can refer them later.



CC-by-mail is an option for posting messages. This option can be accessed using the @l button from the message composer
toolbar. It allows you to reply a message to the public newsgroups as well as to the original message author via personal e-mail.



Multipurpose Internet Mail Extensions is the Internet message format standard.



A Uniform Resource Locator (URL) is a system of identifying where a resource resides anywhere on the Internet. Databases,
images, newsgroups, Gophers, Archies and many other services are capable of being addressed via URLs



Outbox is a folder for holding queued messages. To send queued messages in the Outbox, you can use the Send command in the
File menu.



The USENET News System is a set of bulletins, discussion groups, program sources, and other bits of information distributed
around the world. The information is generally called "articles" and is broken up into "newsgroups". Each newsgroup deals with a
subject or a set of subjects. The subjects for newsgroups are varied from discussions about particular computer hardwares and
softwares to movie reviews to commentary on current social and political issues.



An Internet host running a special software which provides services for exchanging USENET news.



Newsreader is an interface to the USENET news system that allows users to read and write articles by accessing a central news
repository.



An intermediate machine which is used to deliver electronic mail to recipient. It is also known as a mail gateway, or mail bridge.



Transmission Control Protocol/Internet Protocol is a suite of network communications protocols being used in the Internet.



Network News Transfer Protocol is a standard for the distribution, inquiry, retrieval, and posting of articles among the ARPA-Internet
community.



Simple Mail Transfer Protocol is a standard for the exchange of mail between machines.



UUencode is a mechanism for encoding binary streams. It is widely used in USENET.



Base64 is a mechanism for encoding binary streams. It is adopted as a standard encoding mechanism in MIME.



Newsrc file is for storing newsgroups information. Each line shows a newsgroup name in full, followed by the numbers of the articles
that have been read. A colon after the newsgroup name indicates that the newsgroup is subscribed and an exclamation mark
indicates that the newsgroup is unsubscribed.



Thread is a group of articles which are arranged in a reply-ordered sequence to make following them easier, and also makes it easy
to backtrack a specific discussion from the beginning.



XOVER is an NNTP extension for accessing the Overview database in a news server.



Signature file is a plain text file which will be attached at the end of your out-going messages.



Killfile is a filtering mechanism for removing or selecting messages in newsgroups. See also regular expression for specifying killfile
patterns.









